
Subject: output
Posted by tomson on Tue, 18 Mar 2003 03:47:39 GMT
View Forum Message <> Reply to Message

Hi,PS output is very good. But this form cannot be used in Word. When I use
adobe to open PS file and save it as CGM or EMF, sometimes the new file
looks not the same as PS file. What is the matter?

Subject: Re: output
Posted by David Fanning on Tue, 18 Mar 2003 19:45:23 GMT
View Forum Message <> Reply to Message

Mark Hadfield (m.hadfield@niwa.co.nz) writes:

>  "David Fanning" <david@dfanning.com> wrote:
>>  ...Microsoft is even
>>  smart enough to make the PostScript preview from
>>  the pure PostScript file I send it.
>  
>  That's a new one on me!
>  
>>  IDL 5.6 and Microsoft Word 2002 on Windows 2000.
>  
>  It doesn't do that in Word 2000 or earlier. Do you think it's new to Word
>  2002 or do you have some add-on software installed?

I have to admit, it was a new one on me, too.
In fact, I had to load the file twice, being very
careful the second time that I knew exactly what I
was doing, to convince myself I was seeing what I 
thought I was seeing.

It is the first time Microsoft Word has ever done
something on its own that didn't completely piss
me off. :-)

As far as I know, I don't have any special software
installed. I rarely use Word (I *greatly* prefer
Adobe Framemaker for writing documents) and only have
it around to open the odd attachment I get from the
poor suckers who have to put up with it. But I was
pretty impressed with this encapsulated PostScript
filter. Very slick.

Cheers,

David
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-- 
David W. Fanning, Ph.D.
Fanning Software Consulting, Inc.
Phone: 970-221-0438, E-mail: david@dfanning.com
Coyote's Guide to IDL Programming: http://www.dfanning.com/
Toll-Free IDL Book Orders: 1-888-461-0155

Subject: Re: output
Posted by David Fanning on Wed, 19 Mar 2003 01:09:06 GMT
View Forum Message <> Reply to Message

tomson (tom2959@21cn.com) writes:

>  I can insert  EPS into word and it looks good on the screen. When I print
>  the file, it looks not so good as  file by inserting WMF or CGM(vector form)
>  figure. So I always convert PS to WMF. But sometimes  the converted figure
>  is not the same as original one. I am puzzled.

*You* are puzzled!? You certainly have me scratching
my head.

I don't mean any disrespect, but I simply don't believe
you. :-)

I'm going to suggest that if your PostScript output
looks worse when it is printed than it does when it's
on the display, then the PostScript file hasn't been
created properly. In fact, I'm going to suggest there
is about a 90% chance that it is a screenshot (an image),
and NOT real PostScript output, which would be vector
output similar to your beloved CGM.

Perhaps if we could have a peek at the code you
use to produce this PostScript output. :-)

Cheers,

David

-- 
David W. Fanning, Ph.D.
Fanning Software Consulting, Inc.
Phone: 970-221-0438, E-mail: david@dfanning.com
Coyote's Guide to IDL Programming: http://www.dfanning.com/
Toll-Free IDL Book Orders: 1-888-461-0155
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Subject: Re: output
Posted by tomson on Wed, 19 Mar 2003 01:24:34 GMT
View Forum Message <> Reply to Message

I am very sorry for that. This is my setting:

  device,filename='plot.eps',bits=8,/color ,/ENCAPSUL
  DEVICE, SET_FONT='times',/tt_font
  !p.font=1
OR
  device,filename='plot.cgm',colors=2^8,/bin
 (I cannot use set_font??)
OR
  device,filename='plot.wmf',/index_COLOR

Are there anything wrong?

:MPG.18e1711ff3367d51989b21@news.frii.com...
>  tomson (tom2959@21cn.com) writes:
> 
>>  I can insert  EPS into word and it looks good on the screen. When I
print
>>  the file, it looks not so good as  file by inserting WMF or CGM(vector
form)
>>  figure. So I always convert PS to WMF. But sometimes  the converted
figure
>>  is not the same as original one. I am puzzled.
> 
>  *You* are puzzled!? You certainly have me scratching
>  my head.
> 
>  I don't mean any disrespect, but I simply don't believe
>  you. :-)
> 
>  I'm going to suggest that if your PostScript output
>  looks worse when it is printed than it does when it's
>  on the display, then the PostScript file hasn't been
>  created properly. In fact, I'm going to suggest there
>  is about a 90% chance that it is a screenshot (an image),
>  and NOT real PostScript output, which would be vector
>  output similar to your beloved CGM.
> 
>  Perhaps if we could have a peek at the code you
>  use to produce this PostScript output. :-)
> 
>  Cheers,
> 
>  David
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> 
>  --
>  David W. Fanning, Ph.D.
>  Fanning Software Consulting, Inc.
>  Phone: 970-221-0438, E-mail: david@dfanning.com
>  Coyote's Guide to IDL Programming: http://www.dfanning.com/
>  Toll-Free IDL Book Orders: 1-888-461-0155

Subject: Re: output
Posted by David Fanning on Wed, 19 Mar 2003 01:26:33 GMT
View Forum Message <> Reply to Message

tomson (tom2959@21cn.com) writes:

>  I am very sorry for that. This is my setting:
>  
>    device,filename='plot.eps',bits=8,/color ,/ENCAPSUL
>    DEVICE, SET_FONT='times',/tt_font
>    !p.font=1
>  OR
>    device,filename='plot.cgm',colors=2^8,/bin
>   (I cannot use set_font??)
>  OR
>    device,filename='plot.wmf',/index_COLOR
>  
>  Are there anything wrong?

Not yet. :-)

Where is the rest of it? I want to see the commands
that actually produce the PostScript file. That is,
I would like to see the graphics commands you are
using.

Cheers,

David

-- 
David W. Fanning, Ph.D.
Fanning Software Consulting, Inc.
Phone: 970-221-0438, E-mail: david@dfanning.com
Coyote's Guide to IDL Programming: http://www.dfanning.com/
Toll-Free IDL Book Orders: 1-888-461-0155
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Subject: Re: output
Posted by tomson on Wed, 19 Mar 2003 01:59:07 GMT
View Forum Message <> Reply to Message

Others are plot or oplot or xyouts ...

thick0=6
!p.background=white
!p.color=black
!p.position=[0.1,0.1,0.9,0.8]
!p.thick=thick0
!x.thick=thick0
!y.thick=thick0
!z.thick=thick0
!P.charthick=thick0

 plot,t,x(1,*),xrange=[0,13],xstyle=1,xticks=13,yrange=[160,2 20],ystyle=1,$

 xtickname=['Jan','Feb','Mar','Apr','May','Jun','Jul','Agu',' Sep','Oct','Nov'
,'Dec','Jan','Feb'],psym=-8, $
     xtitle='',ytitle='Temperature(K)',line=2
oplot,[xlab1,xlab1+1],[ylab0-5,ylab0-5],line=2 &
oplot,[xlab1+0.5],[ylab0-5],psym=-8
xyouts,xlab1+1.2,ylab0-6,'2002',/data,charsize=chars
xyouts,5,150,'2002'
xyouts,12.,150,'2003'
......

I use gsview to convert PS to EPS. And I donot have PS printer.

:MPG.18e175372731b9d0989b22@news.frii.com...
>  tomson (tom2959@21cn.com) writes:
> 
>>  I am very sorry for that. This is my setting:
>> 
>>    device,filename='plot.eps',bits=8,/color ,/ENCAPSUL
>>    DEVICE, SET_FONT='times',/tt_font
>>    !p.font=1
>>  OR
>>    device,filename='plot.cgm',colors=2^8,/bin
>>   (I cannot use set_font??)
>>  OR
>>    device,filename='plot.wmf',/index_COLOR
>> 
>>  Are there anything wrong?
> 
>  Not yet. :-)
> 

Page 5 of 20 ---- Generated from comp.lang.idl-pvwave archive

http://idlcoyote.com/comp.lang.idl-pvwave/index.php?t=usrinfo&id=4616
http://idlcoyote.com/comp.lang.idl-pvwave/index.php?t=rview&th=17140&goto=34510#msg_34510
http://idlcoyote.com/comp.lang.idl-pvwave/index.php?t=post&reply_to=34510
http://idlcoyote.com/comp.lang.idl-pvwave/index.php


>  Where is the rest of it? I want to see the commands
>  that actually produce the PostScript file. That is,
>  I would like to see the graphics commands you are
>  using.
> 
>  Cheers,
> 
>  David
> 
>  --
>  David W. Fanning, Ph.D.
>  Fanning Software Consulting, Inc.
>  Phone: 970-221-0438, E-mail: david@dfanning.com
>  Coyote's Guide to IDL Programming: http://www.dfanning.com/
>  Toll-Free IDL Book Orders: 1-888-461-0155

Subject: Re: output
Posted by David Fanning on Wed, 19 Mar 2003 02:01:01 GMT
View Forum Message <> Reply to Message

tomson (tom2959@21cn.com) writes:

>  I use gsview to convert PS to EPS. And I donot have PS printer.

Ah, well. 

Let's just say *if* you had a PostScript printer I'm
pretty sure you wouldn't be dissing PostScript output.
It's been fun. :-)

Cheers,

David
-- 
David W. Fanning, Ph.D.
Fanning Software Consulting, Inc.
Phone: 970-221-0438, E-mail: david@dfanning.com
Coyote's Guide to IDL Programming: http://www.dfanning.com/
Toll-Free IDL Book Orders: 1-888-461-0155

Subject: Re: output
Posted by Chad Bender on Wed, 19 Mar 2003 02:05:15 GMT
View Forum Message <> Reply to Message

tomson <tom2959@21cn.com> wrote:
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: I use gsview to convert PS to EPS. And I donot have PS printer.

I'm a little confused by this statement.  From your device commands
earlier, it looked like you are already creating EPS output.  Anyway
I've always found that if you need both ps and eps versions, it is better
to just rerun the plotting commands and create each one from scratch
(with the appropriate encapsulated= keyword).  Converting things is 
always a little iffy.

Chad

Subject: Re: output
Posted by tomson on Wed, 19 Mar 2003 02:06:45 GMT
View Forum Message <> Reply to Message

I am sure. PS looks so good by GSVIEW.

Why no people here use CGM or WMF?

:MPG.18e17d4536d2d50d989b23@news.frii.com...
>  tomson (tom2959@21cn.com) writes:
> 
>>  I use gsview to convert PS to EPS. And I donot have PS printer.
> 
>  Ah, well.
> 
>  Let's just say *if* you had a PostScript printer I'm
>  pretty sure you wouldn't be dissing PostScript output.
>  It's been fun. :-)
> 
>  Cheers,
> 
>  David
>  --
>  David W. Fanning, Ph.D.
>  Fanning Software Consulting, Inc.
>  Phone: 970-221-0438, E-mail: david@dfanning.com
>  Coyote's Guide to IDL Programming: http://www.dfanning.com/
>  Toll-Free IDL Book Orders: 1-888-461-0155

Subject: Re: output
Posted by tomson on Wed, 19 Mar 2003 02:12:53 GMT
View Forum Message <> Reply to Message
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Sorry, I change the code when I read David's post, originally is ps. But I
use word2000.

:3e77d05b_4@marge.ic.sunysb.edu...
>  tomson <tom2959@21cn.com> wrote:
> 
>  : I use gsview to convert PS to EPS. And I donot have PS printer.
> 
>  I'm a little confused by this statement.  From your device commands
>  earlier, it looked like you are already creating EPS output.  Anyway
>  I've always found that if you need both ps and eps versions, it is better
>  to just rerun the plotting commands and create each one from scratch
>  (with the appropriate encapsulated= keyword).  Converting things is
>  always a little iffy.
> 
>  Chad

Subject: Re: output
Posted by tomson on Wed, 19 Mar 2003 02:19:18 GMT
View Forum Message <> Reply to Message

SO the best way is to upgrade to word2002.

:MPG.18e12542f8cc53a2989b20@news.frii.com...
>  Mark Hadfield (m.hadfield@niwa.co.nz) writes:
> 
>>  "David Fanning" <david@dfanning.com> wrote:
>>>  ...Microsoft is even
>>>  smart enough to make the PostScript preview from
>>>  the pure PostScript file I send it.
>> 
>>  That's a new one on me!
>> 
>>>  IDL 5.6 and Microsoft Word 2002 on Windows 2000.
>> 
>>  It doesn't do that in Word 2000 or earlier. Do you think it's new to
Word
>>  2002 or do you have some add-on software installed?
> 
>  I have to admit, it was a new one on me, too.
>  In fact, I had to load the file twice, being very
>  careful the second time that I knew exactly what I
>  was doing, to convince myself I was seeing what I
>  thought I was seeing.
> 
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>  It is the first time Microsoft Word has ever done
>  something on its own that didn't completely piss
>  me off. :-)
> 
>  As far as I know, I don't have any special software
>  installed. I rarely use Word (I *greatly* prefer
>  Adobe Framemaker for writing documents) and only have
>  it around to open the odd attachment I get from the
>  poor suckers who have to put up with it. But I was
>  pretty impressed with this encapsulated PostScript
>  filter. Very slick.
> 
>  Cheers,
> 
>  David
> 
>  --
>  David W. Fanning, Ph.D.
>  Fanning Software Consulting, Inc.
>  Phone: 970-221-0438, E-mail: david@dfanning.com
>  Coyote's Guide to IDL Programming: http://www.dfanning.com/
>  Toll-Free IDL Book Orders: 1-888-461-0155

Subject: Re: output
Posted by David Fanning on Wed, 19 Mar 2003 02:36:41 GMT
View Forum Message <> Reply to Message

tomson (tom2959@21cn.com) writes:
 
>  SO the best way is to upgrade to word2002.

Well, personally, I would spend the money on a PostScript
printer. :-)

Encapsulated PostScript is kind of like that cold capsule
that is half sinus relief and half cold medicine. There
is the PostScript part of the file, which is only used
when the file is printed, and the screen version part,
(sometimes called the preview image) which is used to 
give you something to look at in your document. That's
what you have been basing your PostScript views on.

But the preview is to real PostScript output as store-
bought tomatoes are to those you grow in the garden.
That is to say, they are the same in name only.

If you had a chance to print your output, you would
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realize that immediately. Just as when you eat a real
tomato the juice always drips down your chin.

Cheers,

David

-- 
David W. Fanning, Ph.D.
Fanning Software Consulting, Inc.
Phone: 970-221-0438, E-mail: david@dfanning.com
Coyote's Guide to IDL Programming: http://www.dfanning.com/
Toll-Free IDL Book Orders: 1-888-461-0155

Subject: Re: output
Posted by Mark Hadfield on Wed, 19 Mar 2003 04:40:38 GMT
View Forum Message <> Reply to Message

"David Fanning" <david@dfanning.com> wrote in message
news:MPG.18e185a6879e5d3a989b24@news.frii.com...
>  tomson (tom2959@21cn.com) writes:
> 
>>  SO the best way is to upgrade to word2002.
> 
>  Well, personally, I would spend the money on a PostScript
>  printer. :-)
> 
>  Encapsulated PostScript is kind of like that cold capsule
>  that is half sinus relief and half cold medicine....

I think what David is trying to say is this: -:)

When Word 2000 or earlier imports an EPS file it stores the Postscript code
inside the file but doesn't try to interpret it. On the screen it shows a
very boring box, perhaps with some information from the file header. However
it is possible to add a preview graphic to an EPS file. This is usually a
coarse-resolution image. For some tips on attaching a preview to an EPS file
see the following page on Doc Fanning's site:

  http://www.dfanning.com/tips/postscript_preview.html

(But I'm sure you've already looked there, haven't you.)

If Word finds a suitable preview graphic (TIFF or WMF format) then it
displays that.

What you get when you print depends on the type of printer. If it's a
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Postscript printer, Word sends the Postscript info that it stored; quality
is usually good. If it's a non-Postscript printer, Word prints what it shows
on the screen, either the boring box or the preview; quality is usually bad.

David has suggested that Word 2002 automatically generates an on-screen
graphic from a plain EPS file. I can't give an informed opinion without
seeing this for myself, but I am guessing  that the on-screen graphic is a
coarse-resolution image. If so, then this is a cool trick, but not a major
advance. Then again, maybe I'm wrong.

So it seems that to print embedded EPS files with good quality you still
need a Postscript printer. If you can't afford one of those, you might
achieve a similar effect with Ghostcript. This is a software Postscript
interpreter: it turns Postscript into (usually) images. You can print from
Word via a Postscript printer driver to generate yet another Postscript
file. Then use Ghostscript to turn this into a honking big image of the page
and send that to your printer. Well, something like that, anyway. I've never
had to do this so I can't comment on how easy or successful it is.

For info on Ghostscript and its Windows front end, GSview, see

  http://www.cs.wisc.edu/~ghost/

---
Mark Hadfield            "Ka puwaha te tai nei, Hoea tatou"
m.hadfield@niwa.co.nz
National Institute for Water and Atmospheric Research (NIWA)

Subject: Re: output
Posted by David Fanning on Wed, 19 Mar 2003 04:52:27 GMT
View Forum Message <> Reply to Message

Mark Hadfield (m.hadfield@niwa.co.nz) writes:

>  I think what David is trying to say is this: -:)

No, no. I was trying to make a point about tomatoes. :-)

Cheers,

David

-- 
David W. Fanning, Ph.D.
Fanning Software Consulting, Inc.
Phone: 970-221-0438, E-mail: david@dfanning.com
Coyote's Guide to IDL Programming: http://www.dfanning.com/
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Toll-Free IDL Book Orders: 1-888-461-0155

Subject: Re: output
Posted by tomson on Wed, 19 Mar 2003 08:12:49 GMT
View Forum Message <> Reply to Message

OH, a very good ideal! I can print it in GSVIEW!

Thank you and David. Thank all.

:b58sc9$oc6$1@newsreader.mailgate.org...
>  "David Fanning" <david@dfanning.com> wrote in message
>  news:MPG.18e185a6879e5d3a989b24@news.frii.com...
>>  tomson (tom2959@21cn.com) writes:
>> 
>>>  SO the best way is to upgrade to word2002.
>> 
>>  Well, personally, I would spend the money on a PostScript
>>  printer. :-)
>> 
>>  Encapsulated PostScript is kind of like that cold capsule
>>  that is half sinus relief and half cold medicine....
> 
>  I think what David is trying to say is this: -:)
> 
>  When Word 2000 or earlier imports an EPS file it stores the Postscript
code
>  inside the file but doesn't try to interpret it. On the screen it shows a
>  very boring box, perhaps with some information from the file header.
However
>  it is possible to add a preview graphic to an EPS file. This is usually a
>  coarse-resolution image. For some tips on attaching a preview to an EPS
file
>  see the following page on Doc Fanning's site:
> 
>    http://www.dfanning.com/tips/postscript_preview.html
> 
>  (But I'm sure you've already looked there, haven't you.)
> 
>  If Word finds a suitable preview graphic (TIFF or WMF format) then it
>  displays that.
> 
>  What you get when you print depends on the type of printer. If it's a
>  Postscript printer, Word sends the Postscript info that it stored; quality
>  is usually good. If it's a non-Postscript printer, Word prints what it
shows
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>  on the screen, either the boring box or the preview; quality is usually
bad.
> 
>  David has suggested that Word 2002 automatically generates an on-screen
>  graphic from a plain EPS file. I can't give an informed opinion without
>  seeing this for myself, but I am guessing  that the on-screen graphic is a
>  coarse-resolution image. If so, then this is a cool trick, but not a major
>  advance. Then again, maybe I'm wrong.
> 
>  So it seems that to print embedded EPS files with good quality you still
>  need a Postscript printer. If you can't afford one of those, you might
>  achieve a similar effect with Ghostcript. This is a software Postscript
>  interpreter: it turns Postscript into (usually) images. You can print from
>  Word via a Postscript printer driver to generate yet another Postscript
>  file. Then use Ghostscript to turn this into a honking big image of the
page
>  and send that to your printer. Well, something like that, anyway. I've
never
>  had to do this so I can't comment on how easy or successful it is.
> 
>  For info on Ghostscript and its Windows front end, GSview, see
> 
>    http://www.cs.wisc.edu/~ghost/
> 
>  ---
>  Mark Hadfield            "Ka puwaha te tai nei, Hoea tatou"
>  m.hadfield@niwa.co.nz
>  National Institute for Water and Atmospheric Research (NIWA)
> 
> 
> 
> 
> 

Subject: Re: output
Posted by jeyadev on Wed, 19 Mar 2003 23:38:46 GMT
View Forum Message <> Reply to Message

In article <b58sc9$oc6$1@newsreader.mailgate.org>,
Mark Hadfield <m.hadfield@niwa.co.nz> wrote:
> 
> When Word 2000 or earlier imports an EPS file it stores the Postscript code
> inside the file but doesn't try to interpret it. On the screen it shows a
> very boring box, perhaps with some information from the file header. However
> it is possible to add a preview graphic to an EPS file. This is usually a
> coarse-resolution image. For some tips on attaching a preview to an EPS file
> see the following page on Doc Fanning's site:
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> 
>   http://www.dfanning.com/tips/postscript_preview.html
> 
> (But I'm sure you've already looked there, haven't you.)

Yes, but I work in Unix. Right now, I create the EPS files under Solaris
and then read them into Word. I do not mind the empty boxes, but I do
hate Word (among a million other reasons) when the inserted 'picture'
is moved to heaven knows where because I decided to add a comma 
somewhere in the text. When there are no captions attached to the 
figures, divining which empty box is which is pretty much impossible.
For this reason alone I would like a preview, however bad. Where can
I find a way to doing this? I do not want to create a PDF to the Word
document every two minutes to rearrange it, only to have side effects
..... arrrgh!
 
> For info on Ghostscript and its Windows front end, GSview, see

I had a quick look. Couldn't find what I needed. Could someone
please give the Ghostscript command for making a preview?

thanks

-- 

Surendar Jeyadev         jeyadev@wrc.xerox.bounceback.com
                         
                         Remove 'bounceback' for email address

Subject: Re: output
Posted by Chad Bender on Thu, 20 Mar 2003 00:13:52 GMT
View Forum Message <> Reply to Message

Surendar Jeyadev <jeyadev@wrc.xerox.bounceback.com> wrote:
: In article <b58sc9$oc6$1@newsreader.mailgate.org>,
: Mark Hadfield <m.hadfield@niwa.co.nz> wrote:

: Yes, but I work in Unix. Right now, I create the EPS files under Solaris
: I find a way to doing this? I do not want to create a PDF to the Word
: document every two minutes to rearrange it, only to have side effects

If you're already working under unix, I'd suggest getting a copy of latex.
It's actually probably already installed on your distribution.  It will
handle the EPS files perfectly (as it outputs a dvi format).  Changing
things won't screw up the placement of figures either, as the latex
file is compiled to generate the output file.  The program is quite smart,
and good for all publication quality text formatting.  The only down side
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is that it has a bit of a steep learning curve (probably equivalent to IDL).
You'll need a book to figure things out. "Latex, A Document Preparation
System..." by Leslie Lamport is the standard reference, and is nice because
it includes lots of reference info.  However, it is a bit 
dense, and is definitely not an instruction book.  If you get it, you'll 
probably also need something else, at least to start out with.

Chad

Subject: Re: output
Posted by Mark Hadfield on Thu, 20 Mar 2003 01:27:03 GMT
View Forum Message <> Reply to Message

"Surendar Jeyadev" <jeyadev@wrc.xerox.bounceback.com> wrote in message
news:b5av26$p2p$1@news.wrc.xerox.com...
>  ...When there are no captions attached to the
>  figures, divining which empty box is which is pretty much impossible.
>  For this reason alone I would like a preview, however bad...

Indeed

>  I had a quick look. Couldn't find what I needed. Could someone
>  please give the Ghostscript command for making a preview?

Ghostscript can generate a preview image, but it doesn't know how to add it
to the EPS file. (It can't be all that hard, surely!)

GSview can add a preview in formats suitable for Word. It runs on Windows,
OS2 and Linux.

  http://www.cs.wisc.edu/~ghost/gsview/get43.htm

The same code is available in a command line tool. epstool. There used to be
a WWW page for this but I can't find it now. However this might be worth
checking out:

   ftp://mirror.cs.wisc.edu/pub/mirrors/ghost/ghostgum/epstool- 3.0.tar.gz

By the way, to the best of my recollection there are three preview formats:
device-independent (as added by IDL), TIFF and WMF (Windows metafile). Word
accepts TIFF (but maybe not all variants) and WMF.

Good luck.

--
Mark Hadfield            "Ka puwaha te tai nei, Hoea tatou"
m.hadfield@niwa.co.nz
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National Institute for Water and Atmospheric Research (NIWA)

Subject: Re: output
Posted by Pavel Romashkin on Thu, 20 Mar 2003 17:45:01 GMT
View Forum Message <> Reply to Message

I know that defending Word would attract fierce fire upon me.
But in 1997, I realized when putting together a very complex document
that MS is not stupid by any means. Word has more features than most
people realize. And Word XP is even more advanced that W97.
You can have static pictures that stay on the page in a given position,
and text will "flow" around them. You can (as you do, it is the default)
attach pictures to text anchors and pics will "flow" with the text, and
yes, then they will disappear sometimes.
You can also add captions, automatically with incrementing Figure
numbers, and this is pretty sophisticated.
But it does take a while to figure it all out.
And if you wanted to open VBA and go in there, you can see how it is all
done and do even more.
I will stop here. But the Empire is not stupid and its Word is not so
much of a POS as most people tend to say.
I think that frustration people express is from the fact that MS ships
Word with lots of stupid features aimed at absolute beginners enabled by
default. And they disable most of advanced features by default. And
advanced users never look for them just because they hate the Empire's
guts by default.
Cheers,
Pavel

Surendar Jeyadev wrote:
>  I do not mind the empty boxes, but I do
>  hate Word (among a million other reasons) when the inserted 'picture'
>  is moved to heaven knows where because I decided to add a comma
>  somewhere in the text. When there are no captions attached to the
>  figures, divining which empty box is which is pretty much impossible.
>  For this reason alone I would like a preview, however bad. Where can
>  I find a way to doing this? I do not want to create a PDF to the Word
>  document every two minutes to rearrange it, only to have side effects
>  ..... arrrgh!

Subject: Re: output
Posted by MKatz843 on Thu, 20 Mar 2003 17:55:26 GMT
View Forum Message <> Reply to Message

I bring IDL-created EPS files into Word all the time on Mac OS X and
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it works. Let me add a few comments to this discussion for the Mac
users out there...

When you import the picture it is always best to specify "EPS
Encapsulated PostScript" from the file-dialog pulldown menu before you
find and select the file. This is to prevent Word from trying to
convert the picture to a less useful format.

If you're having touble getting your picture to stay put on a specific
page or in a specific location, then join the club. (This isn't just a
Mac Word issue.) Word is terrible in this regard! Word is not a
reliable layout program (for fonts, graphics, . . . anything.) That
said, I always de-select any option or preference that asks to Float
the Image over the Text. Good luck finding said options. Alternately,
in the Picture > Format > Layout > Advanced menu, make sure the
picture is "In Line with Text" or some similar option. Yes, the image
will flow with the text, but al least you won't find your
bottom-of-page-3 graphic on the bottom of page 4 unexpectedly.

Regarding output. Mac OS X has a built-in PDF-file output mode. File >
Print > Save As PDF. Your EPS graphics will not be rendered properly
using this mode. You will get the low-res screen previews if they
exist. But if you have Adobe Acrobat Distiller, you can make a lovely,
perfect PDF, without a PostScript printer. In the OS X Print Dialog,
set up a (null) printer as "localhost". When you print to localhost,
you'll be writing a postscript file. From that you can use Acrobat
Distiller to render the PDF. It's possible you can also do this from
ghostscript/ghostview--I don't use those programs.

One last warning. A Word document containing EPS graphics that was
created on a Mac/PC may not print properly on a PC/Mac. In fact, if
you drop the phrase "containing EPS graphics" from the previous
sentence it's still true. So much for seamless integration.

Good Luck,
M. Katz

Subject: Re: output
Posted by jeyadev on Fri, 21 Mar 2003 20:30:34 GMT
View Forum Message <> Reply to Message

In article <3e7907c0_2@marge.ic.sunysb.edu>,
Chad Bender  <cbender@hapuna.ess.sunysb.edu> wrote:
> Surendar Jeyadev <jeyadev@wrc.xerox.bounceback.com> wrote:
> : In article <b58sc9$oc6$1@newsreader.mailgate.org>,
> : Mark Hadfield <m.hadfield@niwa.co.nz> wrote:
> 
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> : Yes, but I work in Unix. Right now, I create the EPS files under Solaris
> : I find a way to doing this? I do not want to create a PDF to the Word
> : document every two minutes to rearrange it, only to have side effects
 
Thanks, for the post.

> If you're already working under unix, I'd suggest getting a copy of latex.

I do my work (and read Usenet) under Solaris, but I also have to write
reports to people who use, and must use (!), Word. There is no escaping
that. I never use Word for any external publication, etc., but I do 
have to use it for internal documents. So, it Latex for real work,
Word for the rest.

-- 

Surendar Jeyadev         jeyadev@wrc.xerox.bounceback.com
                         
                         Remove 'bounceback' for email address

Subject: Re: output
Posted by jeyadev on Fri, 21 Mar 2003 20:37:30 GMT
View Forum Message <> Reply to Message

In article <3E79FE1D.9B03D4C2@hotmail.com>,
Pavel Romashkin  <pavel_romashkin@hotmail.com> wrote:
> I know that defending Word would attract fierce fire upon me.
> But in 1997, I realized when putting together a very complex document
> that MS is not stupid by any means. Word has more features than most
> people realize. And Word XP is even more advanced that W97.
> You can have static pictures that stay on the page in a given position,
> and text will "flow" around them. You can (as you do, it is the default)

I do not want to engage in a discussion over Word, but I am aware of 
these features. I am aware of text boxes which can keep your figures
and captions together, instead of flying off in separate directions
when you edit the text. But, the trouble is, the textboxes themselves
can move to anywhere they like if the added text sends the anchor, 
or the frame past the 'current page'. I am not joking when I say
that I once added a single comma to the text and had a twenty two
page document *completely* rearraged! I still keep it to as it is
one of the most entertaining demos I have shown!!

> attach pictures to text anchors and pics will "flow" with the text, and
> yes, then they will disappear sometimes.
> You can also add captions, automatically with incrementing Figure
> numbers, and this is pretty sophisticated.
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Know that.

> But it does take a while to figure it all out.
> And if you wanted to open VBA and go in there, you can see how it is all
> done and do even more.
> I will stop here. But the Empire is not stupid and its Word is not so
> much of a POS as most people tend to say.

Afraid that I have to disagree ....

> I think that frustration people express is from the fact that MS ships
> Word with lots of stupid features aimed at absolute beginners enabled by
> default. And they disable most of advanced features by default. And
> advanced users never look for them just because they hate the Empire's
> guts by default.

Mine is learned trait! 
-- 

Surendar Jeyadev         jeyadev@wrc.xerox.bounceback.com
                         
                         Remove 'bounceback' for email address

Subject: Re: output
Posted by jeyadev on Fri, 21 Mar 2003 20:47:21 GMT
View Forum Message <> Reply to Message

In article <4a097d6a.0303200955.728ea248@posting.google.com>,
M. Katz <MKatz843@onebox.com> wrote:
> I bring IDL-created EPS files into Word all the time on Mac OS X and
> it works. Let me add a few comments to this discussion for the Mac
> users out there...

I did forget to add this. One of the very first documents I wrote
with Word, was on a Mac. The figures could be seen on the screen
very nicely -- not some very low resolution stuff.
 
> If you're having touble getting your picture to stay put on a specific
> page or in a specific location, then join the club. (This isn't just a

I am a life member ... But I hope to retire as soon as possible
so that I do not have to use MS stuff ...

> Mac Word issue.) Word is terrible in this regard! Word is not a
> reliable layout program (for fonts, graphics, . . . anything.) That
> said, I always de-select any option or preference that asks to Float
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> the Image over the Text. Good luck finding said options. Alternately,
> in the Picture > Format > Layout > Advanced menu, make sure the
> picture is "In Line with Text" or some similar option. Yes, the image
> will flow with the text, but al least you won't find your
> bottom-of-page-3 graphic on the bottom of page 4 unexpectedly.

Now here is something they changed, for the worse IMHO, in Word2000.
In Word95, there a layout option (I forget the name) in which the
picture took up the entire horizontal real estate on the page, even
if it did not stretch across the page. In Word2000, this appears 
to be missing. The 'Square' option allows text to creep into the 
sides of picture/frame/textbox. 'In line' does not do it, either.
The only way is to put a text box around the plot and caption and
size the textbox's width to be at least that on the text area. This
will make the text 'break' the way I like it. 
 
> One last warning. A Word document containing EPS graphics that was
> created on a Mac/PC may not print properly on a PC/Mac. In fact, if
> you drop the phrase "containing EPS graphics" from the previous
> sentence it's still true. So much for seamless integration.

Touche!

-- 

Surendar Jeyadev         jeyadev@wrc.xerox.bounceback.com
                         
                         Remove 'bounceback' for email address
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